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About This Document 
This document covers placing the ACE FB in simulation and other procedures for interacting with 
the ACE simulation functionality. 
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Telephone 
Contact us by telephone at the numbers listed below. 
 

Location Organization Phone 
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Support Center 

1-800-822-7673 

Europe Honeywell TAC-EMEA +32-2-728-2704 
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+82-2-799-6317 

People’s 
Republic of 
China 

Honeywell Global TAC - 
China 
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Elsewhere Call your nearest 
Honeywell office. 
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Symbol Definitions 
The following table lists those symbols used in this document to denote certain conditions. 
 

Symbol Definition 
 

 
 

 
ATTENTION: Identifies information that requires special 
consideration.  

 

 

 
TIP: Identifies advice or hints for the user, often in terms of 
performing a task.  

 

 

 
REFERENCE -EXTERNAL: Identifies an additional source of 
information outside of the bookset.  

 

 

 
REFERENCE - INTERNAL: Identifies an additional source of 
information within the bookset.  

 
CAUTION 

 
Indicates a situation which, if not avoided, may result in equipment 
or work (data) on the system being damaged or lost, or may result in 
the inability to properly operate the process. 

  

 
 

 
CAUTION: Indicates a potentially hazardous situation which, if not 
avoided, may result in minor or moderate injury. It may also be used 
to alert against unsafe practices.  

CAUTION symbol on the equipment refers the user to the product 
manual for additional information. The symbol appears next to 
required information in the manual. 

 

 
 

 
WARNING: Indicates a potentially hazardous situation, which, if not 
avoided, could result in serious injury or death. 

WARNING symbol on the equipment refers the user to the product 
manual for additional information. The symbol appears next to 
required information in the manual. 
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Symbol Definition 
 

 
 

 
WARNING, Risk of electrical shock: Potential shock hazard where 
HAZARDOUS LIVE voltages greater than 30 Vrms, 42.4 Vpeak, or 
60 VDC may be accessible. 

 

 
 

 
ESD HAZARD: Danger of an electro-static discharge to which 
equipment may be sensitive. Observe precautions for handling 
electrostatic sensitive devices. 

 

 
 

 
Protective Earth (PE) terminal: Provided for connection of the 
protective earth (green or green/yellow) supply system conductor. 

 

 
 

 
Functional earth terminal: Used for non-safety purposes such as 
noise immunity improvement. NOTE: This connection shall be 
bonded to Protective Earth at the source of supply in accordance 
with national local electrical code requirements. 

 

 
 

 
Earth Ground: Functional earth connection. NOTE: This 
connection shall be bonded to Protective Earth at the source of 
supply in accordance with national and local electrical code 
requirements. 

 

 
 

 
Chassis Ground: Identifies a connection to the chassis or frame of 
the equipment shall be bonded to Protective Earth at the source of 
supply in accordance with national and local electrical code 
requirements. 
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SIM-ACE Purpose 
SIM-ACE is the off-process ACE application in simulation mode. It does not support 
simulation of an on-process ACE application due to potential safety concerns. You can 
use the SIM-ACE to capture a debug version of a CAB program in an ACE controller for 
editing and debugging. You can save the edited CAB to the ERDB, and use it as a CAB 
instance in Control Builder. 

Performance capability 
Common features of SIM-ACE and ACE 

ACE and SIM-ACE controller share the following features: 

• SIM-ACE and ACE use the same system template and executable 

• Upgrade of the ACE software also upgrades SIM-ACE 

• SIM-ACE support for inter-cluster peer-peer communication is similar to ACE. 

• SIM-ACE has the same performance specifications as ACE. See the CEE-base 
Controller Specification and Technical Data for details. 

SIM-ACE and Experion integration considerations 
The following are things you should consider when integrating a SIM-ACE with an 
Experion system. 

• SIM-ACE and ACE require separate licenses 

• You determine the mode of the CEEACE block through the Simulation Enable 
(SIMENABLE) parameter on its Properties form in Control Builder as follows: 

 
If you set… Then, ACE is in… 

SIMENABLE = FALSE (Off) On-process mode 

SIMENABLE = TRUE (On) Simulation mode 
 

• You confirm the simulation state of the CEEACE block through the simulation state 
(SIMSTATE) parameter on its Properties form in Control Builder as follows: 

 
If SIMSTATE is… Then this means it is… 

SIMNONE An on-process ACE, no simulation 



SIM-ACE Purpose 
Performance capability 

2 Experion SIM-ACE User's Guide  R300.1 
 Honeywell 5/06 

SIMRUN  SIM-ACE is running 

SIMFREEZE SIM-ACE execution is freezed 
 

• SIM-ACE requires Experion-PKS Server and Station to support Operator Interface, 
History, and other functions, just like the ACE. 

• Using more SIM-ACE’s than shown below, can deteriorate the performance of the 
system and is not advisable. 

 
If processor system is… Then, recommeded quantity of SIM-

ACE’s should not exceed… 

Single 2 

Dual 4 
 

• SIM-ACE establishes peer-to-peer communication with other SIM-ACE’s on the 
same node as well as on other nodes, as long as thery are associated with the same 
server. 

• Peer-to-Peer communication between simulation and non-simulation environment is 
restricted such that the Non-Simulation environments never consume data from the 
Simulation environments. (OPC is an exception). 

• SIM-ACE can be connected to ControlNet to facilitate peer-to-peer communication 
with a C200 controller on a ControlNet supervisory network. 

• CEE notifications displayed in the station’s Alarm display can be optionally disabled 
at CEE level either during configuration or when the CEE is idle. 

• CAB instances (supported by SIM-ACE) are source level debugged using Visual 
Studio 7.0. Only one Visual Studio debug session at a time can be attached to a SIM-
ACE for CAB. 

• All the blocks that are executing in SIM-ACE supports Dynamic Snapshot 
Save/Restore (CAB instances are the exception). 
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SIM-ACE Planning and Design 

SIM-ACE network connections 
SIM-ACE Ethernet connection types 

SIM-ACE can be connnected to: 

• FTE 

• Experion redundant Ethernet 

• Experion non-redundant Ethernet 

Experion redundant Ethernet connections are automatically utilized between the 
Experion Server and a SIM-ACE. This connection is similar to the Experion Server’s 
connection to the C200 and is used for: 

• operator display 

• notification, and 

• history access 
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Connectiong to a network 
 

 
REFERENCE 

Refer to the Fault Tolerant Ethernet Bridge Implementation Guide for more 
information about FTE network connections. 

Refer to the Ethernet Implementation Guide [hyperlink to be added] for more 
information on Ethernet connection. 

 
Connecting to ControlNet supervisory network 

SIM-ACE can be connected to ControlNet. This allows peer-to-peer communication to 
C200 and other environments on ControlNet. This option is invoked in the ACE function 
block and is used to configure the MACID of the PCIC interface card and is a common 
function for both ACE and SIM-ACE. 

Prerequisites 

The following state should exist, representing a fully functional, active ACE node 
running in simulation (SIM-ACE): 

• ACE node is running in simulation (SIM-ACE) 

• CEEACE function blocks are loaded 

• CM/SCM with strategies built are loaded and active 

Use the following procedure to invoke the ControlNet connection for ACE in simulation 
mode: 

 
Step Action 

1 From the Project tab, double-click the CEEACE icon. The CEEACEFB 
Configuration form appears with the Main tab forward. 

2 In the ACE Location field, configure: 

• the supervisory node IP address 

• the ControlNet Connection by checking the checkbox,  and  

• the ACE MAC Address (MACID) 
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Reviewing SIM-ACE licensing 
Licensing check 

With the Experion R210 release, ACE/SIM-ACE has its own license. Configuration and 
loading of ACE/SIM-ACE is based on the available quantity licenses. 

Refer to the following table for impact on configuration and loading when insufficient 
license quantities exist. 

 
Activity Result 

Configure more 
ACE/SIM-ACE than 
available licenses 

Warning is issued, stating you are using more features 
than current quantity of licenses permit. 

Load more 
ACE/SIM-ACE than 
available licenses 

Error is issued, stating you are using more features than 
current quantity of licenses permit. 

 
Note: It is possible to have a simulation only environment, for example, 

• no ACEs and 2 SIM-ACEs 

Licensing information on displays 
There is licensing information on both Control Builder and Station displays. The 
following table defines the information available. 

 
Location License information 

Controller Builder – 
Engineering Tools License Display 

Limit – amount available 
Configured – amount configured 
Loaded – amount loaded 

Station –  
System License Options Display 

Amount  available 
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Reviewing peer-to-peer communications 
Communication rules for peer-to-peer 

The following are rules for peer-to-peer and simulation/non-simulation communications: 
 

Type Peer-to-peer 
communication 

ACE Can write to another ACE 

Can read from another ACE 

Can write to SIM-ACE 

Cannot read from SIM-ACE 

SIM-ACE Can write to another SIM-ACE 

Can read from SIM-ACE 

Cannot write to ACE 

Can read from ACE 
 

Notes: 

• On a given node, only SIM-ACEs associated with the same engineering database 
must be configured. 

• SIM-ACEs communicates with other SIM-ACEs over FTE or Ethernet provided that 
both must be in the same domain. 

• Peer-to-peer between SIM-ACE and IOLIM/SIOLIM cannnot be configured. 

Subscription periods for SIM-ACE 

You can configure different subscription periods can be defined for each peer. If you 
configure an invalid subscription period, you are notified at the load of the ACE function 
block and the load fails. 
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SIM-ACE Installation and Upgrades 
Refer Software Installation and Upgrade Guide for further details. 

SIM-ACE Configuration 

Activating SIM-ACE 
Creating and configuring SIM-ACE 

The following two procedures show how to: 

• create the ACE controlller 

• configure the ACE controller as SIM-ACE 

Creating the ACE controller 

Use the following procedure to place the ACE in simulation mode (create the SIM-ACE): 
 

Step Action Result 

1 Click File -> New -> Controllers -> ACE 
– Application Control Environment. 

Calls up the ACE Block configuration 
form with Tag Name field highlighted.  
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Step Action Result 

 
 

 

2 Key in desired name of up to 16 
characters or accept the default. Press 
<Tab>. 

Moves the cursor to the Item Name field. 

3 Enter the Item Name. Press <Tab>. Moves the cursor to the Parent Asset 
field. 

4 Enter the Parent Asset name. Press 
<Tab>. 

Moves the cursor to the Execution Order 
in CM. 

5 Enter the Execution Order in CM value. 
Press <Tab>. 

Moves the cursor to the Host IP Address 
field. 
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Step Action Result 

 
TIP 

Host name and Host IP Address are interactive entries. We recommend that you key 
in the Host IP Address first and let the system determine the Host Name 
automatically. This is especially true if you are configuring the ACE block with the 
ACE node offline. In this case, entering the: 

• Host IP address first generates a Warning message, but 

• entering the Host Name first generates an error message. 

When keying in an IP address, use the mouse or the left and right arrow keys to 
move the cursor to locations within the field. Do not press the <Tab> key until the 
complete address is keyed in. 

6 Key in the host pc IP address for the 
ACE node. Press <Tab>. 

Or, press <Tab> to skip this field and 
enter Host Name instead. Acknowledge 
any error message prompts.  

System automatically determines the 
Host Name, when ACE node is online, 
and moves cursor to Host Name field.  

 

 
(Valid IP address entry results in system 
automatically determining the Host 
Name, when ACE node is online.) 

7 If Host Name has been automatically 
determined, press <Tab>. 

Or, Key in name assigned to the host pc 
for the ACE node. There is a 255-
character limit on this field. Press <Tab> 

(Valid Host Name entry results in 
system automatically determining the 
Host IP Address, when ACE node is 
online.) 

Moves cursor to ControlNet Connection 
field.  

 

 

8 Leave the box unchecked, if ACE is not 
connected to the ControlNet network.  
Check the box, if ACE is connected to 
the ControlNet network. Press <Tab>.  

If the ControlNet Connection box is 
unchecked, cursor moves to Time Zone 
field, since the preceding fields are 
unavailable. Go to Step 10. 

If the box is checked, cursor moves to 
ACE Mac Address field. 

 

http://www.worldtimeserver.com/


SIM-ACE Configuration 
Activating SIM-ACE 

10 Experion SIM-ACE User's Guide  R300.1 
 Honeywell 5/06 

Step Action Result 

 

9 Key in the Media Access Control (MAC) 
address assigned to the PCIC card 
installed the ACE node for ControlNet 
connections.  Press <Tab>. 

Moves cursor to the Time Zone field, 
since the ACE Command field is 
unavailable in the Project mode and the 
ACE State field is read only.  Must be 
configured for each CEE. 

 

 

 
TIP 

The time zone represents the offset value from the Greenwich Mean Time (GMT) 
based on your geographical location. For example, the time zone value for a CPM 
located in the Eastern time zone of the United States that is currently not observing 
daylight savings time would be -05.0 or -5. Always use the offset value that is not 
adjusted for daylight savings time as the entry for the Time Zone field. For example, 
the adjusted offset value for the Eastern time zone of the United States is -04.0, but 
use the unadjusted value of -5 instead. 

You may want to visit the http://www.worldtimeserver.com/ website, if you have a 
question about the appropriate offset value for your given location.  

10 Key in the appropriate time zone offset 
value for the location where the ACE is 
installed. Press <Tab>. 

Moves cursor to Daylight Savings Time 
check box. Must be configured for each 
CEE. 

 

 

11 Leave box unchecked, if Daylight 
Savings Time is not currently being 
observed at your location. Or,  

Check the box, if Daylight Savings time 
is currently being observed at your 
location.  

Press <Tab>. 

Moves cursor to Year Format field.  
 

 

12 
Accept default or click  down-arrow 
button and select desired format from 
the list. Press <Tab>. 

Moves cursor to Weekday Format field.  
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Step Action Result 

13 
Accept default or click  down-arrow 
button and select desired format from 
the list. Click the Server History tab. 

Calls up the Server History configuration 
form. 

 
Continue defining other tabs. Refer to the Control Builder User Guide for additional tab 
configuration information. 

Configuring the ACE controller as SIM-ACE 
Use the following procedure to place the ACE in simulation mode (create the SIM-ACE): 

 
Step Action 

1 From the Project tab, double-click the CEEACE FB and the Main tab appears 
forward. Select Simulation Enable by checking the checkbox (SIMENABLE 
= TRUE). 

Select Inhibit Notifications – CEE and Contents to inhibit notifications. 
Refer to Inhibiting SIM-ACE notifications for additional information. 

Note: To switch between simulation and non-simulation modes, the ACE FB 
execution needs to: 

• shutdown and loaded, toggling the SIMENABLE parameter 
 
Loading SIM-ACE 

Prerequistes 

• This procedure assumes that the ACE controller software is installed and the ACE 
node is capable of communicating with the Server. 

Use the following procedure to load the ACE block with simulation enabled to the ACE 
controller: 

 
Step Action 

1 Click the desired SIM-ACE block icon in the Project tab. 

2 From the Load/Upload menu, select Load or click the Load button in the 
toolbar. 

3 The Load Dialog appears, click OK. This initiates the load and calls up the 
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Step Action 
load progress dialog. 

NOTE: After loading, the icon color is blue. After the CEERUN command is 
run, the icon is the color green. 

  
Successful load of SIM-ACE  

Use the following procedure to check for a successful load of SIM-ACE: 
 

Step Action 

1 From the Monitoring tab, double-click the CEEACE icon. The CEEACEFB 
Configuration form appears with the Main tab forward and 

• CPMSTATE = CEEIDLE 

• CEESTATE = IDLE 
 
Load fails for SIM-ACE 

If the SIM-ACE Host computer (HOST) configuration does not identify an accessible 
computer with ACE software already installed, the ACE/CEEACE FBs load fails.  The 
ACE and CEEACE blocks do not appear in the Monitoring tab of Control Builder. 

Use the following procedure to correct the SIM-ACE load failure: 
 

Step Action 

1 SIM-ACE node software installation must be completed, 
refer to the Software Installation and Upgrade Guide. 

2 The SIM-ACE Host computer configuration must be corrected and the load 
should be re-attempted. Refer to Reloading SIM-ACE. 

 
NOTE: A new ACE block does not have to be created in order to make the SIM-ACE 
Host computer correction. The previously configured ACE template is used to make the 
correction. 

If the ACE host m/c configuration changes, then the CM/SCM’s assigned to this ACE, 
needs to be re-loaded This is necessary because the SIM-ACE communication path was 
changed, which causes the relative communication paths from other peers to SIM-ACE, 
to also change. The relative communication path is computed at load-time; therefore, the 
re-load is required. 
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Reloading SIM-ACE 

Prerequisites 

• To reload ACE/CEEACE FBs, the CEEACE must be in an Idle state. 

Use the following procedure to reload the SIM-ACE: 
 

Step Action 

1 From the Monitoring tab, double-click the CEEACE icon. The CEEACEFB 
Configuration form appears with the Main tab forward. 

2 Change the CEE State to Idle. This is for both the ACE and SIM-ACE 
controller. 

3 ACE/CEEACE FBs must be reloaded. The CM/SCM’s assigned to this ACE 
or SIM-ACE must also be reloaded 

Refer to Loading SIM-ACE to oad SIM-ACE. 
 
Creating and loading OPC Server FB 

Prerequisites 

• The OPC Server FB should be loaded prior to loading any strategies that contain 
references to the OPC Server FB. 

Considerations 

The following are considerations to create and load the OPC Server FB:  

• the OPC Server FB should be loaded prior to loading any strategies that contain 
references to the OPC Server FB 
 
If the OPC Server FB is not loaded before stratgeies that reference OPC Server data, 
then: 

− Control strategies can not communicate with the OPC Server 

− Fail-safe values are substituted for Gets of OPC Server data 

− Attempted Stores to the OPC Server fails 

Note: The field Host IP Address, Host name, and the OPC Server PROGID of the OPC 
FB in the OPC Server FB system template are grayed, when the OPC FB instance is in 
the monitoring part of the database and the system template is opened in the project side. 
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To change any of the above-mentioned fields, the OPC FB must be deleted from the 
monitoring side of the database. This also applies to ACE for HOSTIPPRI, 
HOSTNAMEPRI, and CNETCONNECT. 

 

 
 

OPC –Server configuration form with grayed out boxes 

Use the folowing procedure to create and load an OPC Server: 
 

Step Action 

1 From the File menu, select New, External Servers, and OPC – Server. The 
OPC configuration form appears with the Main tab forward. 

2 On the Main tab of the OPC FB configuration form, define the following fields: 

• Tag Name – default name is displayed 

• Item Name 

• Parent Asset 

• Description – default description is displayed 

• Host IP Address 

• Host name 

• OPC Server PROGID 
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Creating and loading Control Module FB 
The scenario described below applies for both standard FBs and CCL FBs. 

• An unassigned Control Module is assigned to a CEEACE, and  

• if an already assigned CM is changed and saved, 

CM contents are checked to see if any of the contained basic blocks are not supported by 
the SIM-ACE or ACE platform. 

For example, it can be attempted to assign a CM with an AI Channel FB to a CEEACE 
that is associated with an ACE FB. When this mismatch is discovered, the assignment or 
save operation is not completed. 

If the above build-time validation does not catch this error, the load of a CM that contains 
basic blocks, not supported by the SIM-ACE or ACE platform fails. 

Use the following procedure to create and load an CM FB: 
 

Step Action 

1 From the File menu, select New, and Control Module.  

2 From the Projects Tab, right-click the Control Module, selecting Module 
Properties… from the pull-down menu. On the Main tab of the CM FB 
configuration form, define the following fields: 

• Tag Name – default name is displayed 

• Description – default description is displayed 
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Defining simulation command SIMCOMMAND settings 
 

 
ATTENTION 

To access SIMCOMMAND requires the ShadowPlant application. This is a 
licensed apllication. 

 
SIMCOMMAND considerations 

Shadow Plant or Engineer can issue SIMCOMMAND only when the SIMENABLE is 
TRUE. SIMCOMMAND has PointBuild and Engineer access lock. 

 
If SIMCOMMAND is Then 

SIMFREEZE This commands a freeze of CEEACE and simulation is 
stopped. This command is issued for a save/restore, 
dynamic data snapshot, or for Single/Multi-Step execution. 

SIMRUN This commands a start of CEEACE and simulation begins 
from where it previously stopped. 

SIMDISABLE The Engineer uses this command to unfreeze the 
simulation. On receiving this command SIMSTATE = 
SIMRUN. 

NONE The engineer has not commanded CEEACE, or the 
SIMCOMMAND has not been processed. 
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Defining simulation state (SIMSTATE) settings 
SIMSTATE considerations 

SIMSTATE parameter is used within the Experion to identify whether an execution 
environment is in simulation or not. 

The following are the SIMSTATE settings and descriptions. 
 

If SIMSTATE is Then 

SIMFREEZE Indicates that ACE had finished executing single or multiple 
step or a commanded FREEZE to Save/Restore snapshot 
was issued. 

SIMRUN Indicates that ACE is in Simulation mode and the blocks 
are being executed. 

SIMNONE Indicates that ACE is not running in simulation mode 
 
Use case scenario 

The following table reflects user actions, the required setting, and the link to accomplish 
the action. 

 
Step Action SIM setting Link to do activity 

1 User needs to Save/Restore a dynamic 
snapshot –  
SIM-ACE execution needs to stop 

SIMFREEZE  

Freezing 
simulation 

2 User needs to restart simulation -  
SIM-ACE execution needs to run 

SIMRUN Successful load of 
SIM-ACE 

 
If SIMFREEZE command is issued, then the Engineer can command SIMDISABLE to 
unfreeze the execution resulting in SIMSTATE being set to SIMRUN.  

Note: In SIM-ACE the SIMSTATE is never SIMNONE, and in 
 on-process ACE, SIMSTATE = SIMNONE. 
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SIMSTATE transitions in CEEACE 

The table shown below depicts what happens when Shadow Plant issues 
SIMCOMMAND and how it affects the SIMSTATE. 

 
SIMCOMMAND Command 

issued by 
Previous 

SIMSTATE 
SIMSTATE after issuing 

SIMCOMMAND 

SIMFREEZE ShadowPlant SIMRUN 
or 
SIMFRREZE 

SIMSTATE = SIMFREEZE  
All the blocks stop executing their 
algorithms. But the parameter 
requests continue to be processed. 

SIMRUN ShadowPlant SIMFREEZE SIMSTATE = SIMRUN 
All the blocks start executing their 
algorithms based on the CEESTATE. 
The parameter requests continue to 
be processed 

SIMRUN ShadowPlant SIMRUN No change since 
SIMSTATE = SIMRUN already. 

SIMDISABLE ShadowPlant 
or 
Engineer 

SIMRUN 
or 
SIMFRREZE 

SIMSTATE = SIMRUN 
SIMDISABLE is used when 
ShadowPlant exits, leaving 
SIMSTATE in SIMFREEZE. 
If SIMSTATE = SIMRUN then there is 
no change. 
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Defining simulation levels using SIMMODE 
SIMMODEand SIMSTATE interdependencies 

SIMMODE is available in the interface blocks UCNOUT, EHGOUT and HIWAYOUT 
FB. SIMMODE’s settings are dependent on the setting of SIMSTATE, refer to table 
below. 

 
If Then 

SIMSTATE = SIMNONE SIMMODE is always NONE 

SIMSTATE is not SIMNONE SIMMODE can take the value NONE, 
INITDISABLE and DIRECTSUB. 
Refer to ATTENTION below. 

 
Refer to table below for impact of the SIMMODE setting. 

 
If SIMMODE 

setting is 
Then the mpact of this setting is 

SIMMODE = NONE, then OUT blocks are communicating with 
substitute or real OPC Server as usual. 

− OUT block can initiate read/write through OPC server FB.
 
If SIMENABLE = FALSE 
then only real OPC is configured 
 
If SIMENABLE = TRUE 
then only substitute OPC Server is configured. 

NONE 

 
ATTENTION 

Real and substitute OPC servers cannot be distinguished.
 
If the real OPC Server is configured with SIM-ACE, then 
Read and Write is possible. This can lead to simulation 
environment writing to the Real environment. 

The user should be careful that SIM-ACE (with untested 
strategies possibly) is not used with real OPC Server to 
control real devices. 
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If SIMMODE 
setting is 

Then the mpact of this setting is 

INITDISABLE • OUT Blocks are prevented from initializing the primary block 

• Operator can directly write to the parameters EULO and 
EUSPAN100 in the SECDATA side of OUT blocks, which are 
passed to the primary block. 

• The Primary generates the value, regardless of the status of 
the OUT block. There is no need for OPC Function block or 
external simulators. Simulation is done in the Control Strategy 
within the ACE environment. 

DIRECTSUB When the SIMMODE = DIRECTSUB Shadow Plant reads and 
writes directly to SECDATA through Control Data Access since 
ShadowPlant is a CDA client. In this case OPC Function Block is 
not needed. ShadowPlant initiates read and write. 

 
SIMMODE in on-process ACE 

SIMMODE parameter is available in case of on-process ACE also. But it is not enabled. 
SIMMODE = NONE and its value cannot be changed.  
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SIM-ACE Operations 

Startup and shutdown of SIM-ACE node 
Startup and Shutdown 

The SIM-ACE node needs to be powered on and booted up for use. The SIM-ACE does 
not support any startup functions. 

Inhibiting SIM-ACE notifications 
Active SIM-ACE and ACE notification 

If ACE and SIM-ACE controllers exist as different nodes and are connected to the same 
Experion server, notifications from both SIM-ACE and ACE are displayed in Station’s 
Alarm Display page. Allowing SIM-ACE to generate alarms in this environment, could 
lead to confusion. The NOTIFINHIBIT option in the SIM-ACE prevents the notifications 
from the SIM-ACE environment from being displayed in the station’s alarm display 
page. 

Prerequisites 

• You defined a SIM-ACE controller. 
In on-process ACE, the NOTIFINHIBIT option is disabled. 
NOTIFINHIBIT parameter is not exposed in the CEEACE FB template when 
SIMENABLE is FALSE. 

• The CEEACE icon appears in the Monitoring tab. 

• The NOTIFINHIBIT parameter has an access lock of Engineer. 

• NOTIFINHIBIT is configured in the project side. 

Considerations 

• On selecting NOTIFINHIBIT, the notifications generated by the execution 
environment will not be reported in the stations alarm display. 

• NOTIFINHIBIT parameter will not affect the events and INALAM indication. 
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Use the following procedure to inhibit the displaying of alarm notifications: 
 

Step Action 

1 From the Monitoring tab, double-click the CEEACE icon. The CEEACEFB 
Configuration form appears with the Main tab forward. 

2 From the Command/State field, select Inhibit Notifications – CEE and 
Contents to inhibit notifications.  

NOTE: From the monitoring side, NOTIFINHIBIT can only be set/reset when 
the CEESTATE is IDLE. This is enforced because notifications are 
regenerated when the CEESTATE transition from IDLE to RUN. 

 

Switching between SIM-ACE and ACE environment 
Changing host IP address 

Prerequisites 

• ACE FB (ACE01 and ACE02) is loaded successfully in a simulation mode 
(SIMENABLE = TRUE) and both executing in the same hardware node. 

• Suppose ACE01 needs to be switched to non-Simulation mode, then it needs to run on 
a different Hardware node. This needs to be done because SIM-ACE and ACE 
cannot run on the same node. 

Assume that you change the Hostname and IP Address and save the new 
configuration without deleting the loaded instance. The new configuration is updated 
in the ERDB. ERDB at this instance is inconsistent with ACE01 because ACE01 is 
executing in the host, rather than the host details in ERDB.  

To avoid the inconsistency between the ERDB and the ACE01 process Host IP Address, 
Host name field and ControlNet connection option needs to be grayed in the ACE FB 
configuration form until the ACE01 is deleted in the monitoring part of the database. 

This applies even when the ACE FB is in Shutdown state in the monitoring view in the 
Control Builder. In this case static/structural snapshot file is holding the inconsistent 
data. So irrespective of the state of ACE01 FB in the monitoring part of the database, 
ACE01 needs to be deleted in order to edit the Host info fields. 

Considerations 

• ACE01’s host name and IP address need to be reconfigured in addition to setting 
SIMENABLE = FALSE. 
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Use the following procedure to change the host IP address: 
 

Step Action 

1 From the Monitoring tab, double-click the ACE FB icon. The Main tab 
appears forward. 

2 In the ACE Location group, change the Host IP Addess 

3 On the CEEACE FB Main Tab, ensure Simulation Enable and Inhibit 
Notifications – CEE and Contents are unchecked. 

 
Implications of changing a simulation controller to an on-process controller. 

 
Active simulation 

controllers 
Required activity 

ACE01 
ACE02 

Both executing in 
same hardware node 

a) ACE01 needs to be switched to non-simulation mode 

• Then ACE01 is required to run on a different 
hardware node 

• ACE01’s host name and IP address needs to be 
reconfigured 

• SIMENABLE = FALSE. This is required because SIM-
ACE and ACE cannot run on the same node. 

ACE02 remains configured as previously defined. 

   ACE01 FB in the monitoring part of the database  
 needs to be deleted in order to edit the Host info 
 fields. 
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 b) If you change the Hostname and IP Address and save 
the new configuration without deleting the loaded 
instance the following occurs 

• New configuration is updated in the ERDB 

• The ERDB at this instance is inconsistent with ACE01, 
because ACE01 is executing in host other than the host 
details in ERDB. 

− To avoid the inconsistency between the ERDB and 
the ACE01 process Host IP Address, Host name 
field and ControlNet connection option needs to be 
grayed in the ACE FB configuration form till the 
ACE01 is deleted in the monitoring part of the 
database. 

− This applies even when the ACE FB is in 
Shutdown state in the monitoring view in the Control 
Builder. In this case static/structural snapshot file is 
holding the inconsistent data. So irrespective of the 
state of ACE01 FB in the monitoring part of the 
database ACE01 needs to be deleted in order to 
edit the Host info fields. 

 
Scenario – Switching ACE and SIM-ACE 

Use the folloing procedure to switch from ACE on-process to SIM-ACE: 
 

Step Action 

1 From the Project tab, double-click the CEEACE icon. The CEEACEFB 
Configuration form appears with the Main tab forward. 

2 From the Command/State group, check Simulation Enable in its 
checkbox 

• This sets  SIMENABLE = TRUE 
 Note: On-process setting is SIMENABLE = FALSE 

3 Shutdown and load the ACE FB. 

• Refer to the following sections: 
   

• Shutdown a SIM-ACE 
  Loading SIM-ACE 

• The shutting down and reloading of the ACE FB sets: 
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Step Action 
  ACE FB to :  CPMSTATE is CEEIDLE 
  CEEACE FB to: CEESTATE is IDLE 

• If an attempt is made to switch between ACE & SIM-ACE online (i.e 
when ACE FB is loaded) then load fails and CPMSTATE of the ACE FB 
is set to NOCEE. 

4 Set SIMCOMMAND  - only ShadowPlant and an Engineer (access 
priviledge) can write to this parameter and command start and stop of 
execution. Once this parameter’s value is accepted – it goes back to 
NONE. 

SIMCOMMAND selections – refer to  

Defining simulation command SIMCOMMAND settings for detailed 
information. 

• NONE  no change 

• SIMFREEZE  stops simulation 

• SIMRUN  simulation starts (from previous location if it was in a 
  SIMFREEZE state) 

• SIMDISABLE  unfreezes simulation 

Note: Commands SIMRUN and SIMFREEZE can only be issued by 
Shadow Plant. 

5 Set SIMSTATE is a read-only parameter. 
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Freezing simulation 
SIM-ACE freezing simulation considerations 

SIM-ACE can be placed in a freeze state by issusing a SIMFREEZE command.  

A request to initiate a SIMFREEZE is made to the CEEACE FB SIMCOMMAND 
paramter and status checks are performed (prior to placing SIM-ACE in SIMFREEZE). 
These checks include: 

• parameter value range checks 

• access level range checks 

Use the following procedure to place SIM-ACE in a freeze state: 
 

Step Action 

1 Only the ShadowPlant application can freeze the simulation.  

2 From theShadowPlant menu select the Freeze/Unfreeze icon. This issues a 
SIMFREEZE/SIMRUN SIMCOMMAND based on the previous state.  

3 The SIMSTATE changes to SIMFREEZE, if the previous state was SIMRUN. 
 

Use the following table to validate a succssful SIMFREEZE configuration: 
 

Store status SIMSTATE status Result 

Successful SIMSTATE changes 
to SIMFREEZE 

When block execution resumes, 
scheduler stops execution of all blocks 

Unsuccessful SIMSTATE stays at 
previous state 

Error messages appear. 
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Shutdown a SIM-ACE 
SIM-ACE shutdown considerations 

To place a SIM-ACE in shutdown requires the CEESTATE is set to Idle. 
Follow the procedure in the table below. 

 
Step Action 

1 On the SIM-ACE FB, select the CEESTATE checkbox, setting 
the state to Idle. After the shutdown the following occurs: 

• Processing is stopped on the SIM-ACE node 

• CDA-sp service continues to run 

• If the ACE FB still is displayed on the Monitoring tab, the 
following errors are indicated for the blocks associated with 
SIM-ACE: 

− ACE FB is yellow 

− CEEACE and CM/SCM are red 

These indicators are activated because communications with 
the FBs have been lost. 
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Deleting a SIM-ACE 
Deleting SIM-ACE from the Project side 

Prerequistes 

The SIM-ACE can be deleted from the Project side when it: 

• Does not exist on the Monitor tab 

• The ACE FB (in similation) has no control strategies assigned to the CEEACE FB. 

Use the folowing procedure to delete a SIM-ACE from the Project side: 
 

Step Action 

1 Fom the Project tab, select the ACE FB to be deleted. 

2 From the Edit menu, select Execution Environment 
Assignment. The Execution Environment Assignment dialog 
appears. 

3 From the Avaialble Module are: 

• Click the “Show All” button. 

• Select the module assigned to the CEEACE controller. 

4 From the Assigned Modules area: 

• Select the module that is assigned to your controller. 

• Click the Unassign button at the botton of the dialog. 
 
Note: On the Project tab, the module is placed back in the 
unassigned location. 

• Close the Execution Environment Assignment dialog. 

5 Select the ACE controller on the Project tab. 

6 From the Edit menu, select Delete. The Deleted Selected 
object(s) dialog box appears listing the objects to be deleted. 

7 Click the Deleted Selected object(s) button.  

8 The ACE controller is deleted from the Project tab. 
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Deleting SIM-ACE from the Monitor tab 

Prerequistes 

The SIM-ACE can be deleted from the Monitor tab when: 

• CEECOMMAND is IDLE then, CEESTATE can be set to Idle 

• The ACE FB (in similation) has no control strategies assigned to the CEEACE FB. 

Use the following table to delete a SIM-ACE from the Monitor tab: 
  

Step Action Result 

1 In Monitor Mode, open root 
directory for ACE/CEEACE.  

Exposes contents of the CEEACE.  

2 Right-click the CEEACE block and 
select Inactivate->Selected CEE(s), 
IOMs, CMs, Applicable Function 
Blocks from the shortcut menu.  

Inactivates all components including 
the CEEACE. Block icons turn blue.  

 
TIP 

If ACE/CEEACE and its assigned components have been loaded, you must 
first put the CEEACE in its Idle mode and delete all of its components in the 
Monitor mode before you can delete them from the Project mode. 

3 Select components contained in 

CEEACE and click  delete 
button in the tool bar.  

Calls up Delete Selected Objects 
dialog.  

4 Click the Deleted Selected 
Object(s) button.  

Initiates the delete function and 
progress dialog tracks status until 
complete.  

5 Click the ACE block and click the 
delete button in the tool bar.  

Calls up Delete Selected Objects 
dialog. 

6 Click the Delete Selected object(s) 
button.  

Initiates the delete function and 
progress dialog tracks status until 
complete. 

7 Click the Project tab.  Calls up the Project view.  
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Step Action Result 

 
 

8 
With ACE selected, click  assign 
button in the tool bar.  

Opens the Execution Environment 
Assignment dialog box.  
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Step Action Result 

9 Click module assigned to ACE in 
Available Modules list, select 
CEEACE in Assign To list, select all 
the modules listed in the Assigned 
Modules list and click the Unassign 
button.    

Unassigns modules from CEEACE.   

10 Click the Close button.  Closes dialog box and returns to 
Project view.  

11 
With ACE selected, click  delete 
button in tool bar.  

Calls up Delete Selected Objects 
dialog. 

 
 

 
12 Click the Delete Selected object(s) 

button.  
Initiates the delete function and 
progress dialog tracks status until 
complete. 

 

 
 

13 This completes the deleting 
ACE/CEEACE procedure.  

Stops the ace.exe on the ACE node, 
but the Control Data Access for 
supervisory platform (CDA-sp) 
continues to run.  
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Debugging CAB programs in SIM-ACE 
 

 
REFERENCE - INTERNAL 

To find the procedures to debug CAB programs in SIM-ACE, refer to the CAB 
on ACE User Guide. 

  

 
ATTENTION 

If the debugger is attached to the on-process ACE, the application shuts 
down or terminates. 

 
You debug CAB programs in Simulation mode. You utilize the source level debug 
capabilities of the Microsoft Visual Studio 7.0 that includes: 

• single step execution, 

• break points that can be set and viewed directly within the source code and 

• the ability to examine internal variables during break. 

The debug build contains additional information to be used by the source level debugger 
and is different from the release build.  

Site practice must control the services and applications that are allowed on an on-process 
ACE to ensure debugging does not impact an on-process system. 

Local debugging 
For complete procedural instructions on debugging CAB programs in SIM-ACE, refer to 
CAB on ACE User Guide. 

Local debugging activities 

The following are activities associated with local debugging: 

• save the build to ERDB 

• load an instance of a block to SIM-ACE. After loading the block, attach the Microsoft 
Visual studio debugger to the ACE process in a simulation mode 

• you iterate through as many variations of the block type as needed to eliminate 
defects 

• once the defects are removed, SIM-ACE debugging is complete 
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Other considerations 

• Attaching a MSVS debugger inadvertently to an on-process ACE or any other on-
process EPKS subsystem leads to serious user error with loss of control or view.  

• To ensure safety, source level debugging can be used with SIM-ACE and ACE with 
debug build started as a debug console. 

• You can set a release build option, to make a final build to the release target. This 
can be saved to ERDB and maintained as the useable block type.  

• The precautionary measure below is taken care in ACE, SIM-ACE and CAB, against 
inadvertent setting of break points by end-users in on-process controllers. 

− ACE installation supports optional installation of MSVS remote debugging 
components with the warning that remote debugging components should only be 
installed on the nodes that are to host SIM-ACE. 

• If the Machine Debug Manager (MDM) service is installed and running on a node 
which hosts on-process ACE, either in a cutover scenario or inadvertently, the ACE 
process determines the state of the service both at startup and periodically, and 
prevent the CEE transition to RUN.  

− An urgent priority system diagnostic alarm is generated. 

− The alarm message indicating “MDM Service running” is displayed in the 
station. 

− If you try to give the CEECOMMAND as ‘RUN’ when MDM service is running 
an error message is thrown indicating “CEE can’t be activated when the MDM 
service is running”. In this case to activate the CEE, you first stop the MDM 
service and try the CEECOMMAND ‘RUN’.  



SIM-ACE Operations 
Saving non-structural data 

34 Experion SIM-ACE User's Guide  R300.1 
 Honeywell 5/06 

Remote debugging 
 

 
REFERENCE - INTERNAL 

To find the procedures to debug CAB programs in SIM-ACE, refer to [hyerlink 
to CAB on ACE doc]. 

 

Remote debugging considerations 

Remote debugging can be done only if MDM service is installed on the ACE node. This 
service is installed as part of remote debugging components setup during ACE 
installation, only if the CAB License exists.  

Refer to CAB on ACE User Guide for additional information. 

Saving non-structural data 
Considerations 

Saving a non-structural data snapshot translates into a command to all SIM-ACEs. This 
command is applicable to all SIM-ACE’s in the system. 

Following are considerations when saving non-structural data. 
 

Action Result 

Control library interface checks if 
SIMSTATE = SIMFREEZE 

If it is not SIMFREEZE, the command is 
rejected.  

• Save in this SIMSTATE is not allowed 
because the simulation database may not 
have been stopped or frozen. 

If it is SIMFREEZE, the command is accepted.  

• The control library then reads the latest 
values of DYNSTATE parameter from the 
controller. All the loadable parameters, as 
well as dynamic state variables, are stored in 
snapshot file on the machine where the 
Experion server is running. 

Save operation is not successful if 
there is communication failure 
during save operation. 

It is the responsibility of the engineer to restart 
the save operation. 
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Restoring non-structural data 
Considerations 

Restoring a non-structural data snapshot translates into a command to all SIM-ACEs. 
This command is applicable to all SIM-ACE’s in the system. Snapshot save location is 
configurable from the ShadowPlant side. 

Following are considerations when restoring non-structural data. 
 

Action Result 

Control library interface checks if 
SIMSTATE = SIMFREEZE 

If it is not SIMFREEZE, the command is 
rejected.  

• Restore in this SIMSTATE is not allowed 
because the simulation database may not 
have been stopped or frozen. 

If it is SIMFREEZE, the command is accepted.  

• Dynamic data snapshot files that were 
saved previously can be used to restore SIM-
ACE.  

• All dynamic state variables are restored to 
the controller. 

Restore operation is not 
successful if there is 
communication failure during save 
operation. 

It is the responsibility of the engineer to restart 
the restore operation. 

Events are reported when the non-structural data is restored. This means that the 
event journal always contains a record of when the snapshot was restored. 
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SIM-ACE System Administration 

Local SIM-ACE Node Administration 
SIM-ACE node administration is done locally. Keyboard, mouse, and monitor should be 
available to connect to the SIM-ACE node, when reviewing/adjusting administration 
settings. Node administration function includes: 

• checking status of node services, 

• using node performance tools, or 

• starting and stopping other applications on the node 
 

 
ATTENTION 

The system does not prevent the user from installing and executing other 
applications on the same node as SIM-ACE or Experion applications. For 
robust and reliable SIM-ACE control, it is highly recommended that only SIM-
ACE related applications are hosted on the SIM-ACE node. 
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SIM-ACE Troubleshooting and Maintenance 

Recovering from SIM-ACE node power failure 
Prerequisites 

The following state should exist, representing a fully functional, active ACE node 
running in simulation (SIM-ACE): 

• ACE node is running in simulation (SIM-ACE) 

• CEEACE function blocks are loaded 

• CM/SCM with strategies built are loaded and active 

Indications of failure 
If the SIM-ACE loses power the following occurs: 

• Loss of Communications with Controller event is generated 

• Errors are indicated on the Monitoring tab icons for the ACE, CEEACE, and 
CM/SCM FBs assocaiated with SIM-ACE 

• Lower level strategies dependent on the SIM-ACE for supervisory control sheds to 
their configured backup modes. 

Recovering from node power failure 
Use the following procedure to recover from a SIM-ACE power failure 

 
Step Action 

1 Restore power to SIM-ACE node. 

2 Boot up the SIM-ACE node (all necessary SIM-ACE 
processes starts automatically) 

3 Select ACE FB from Monitoring tab. From the Snapshot 
menu, select Restore Controller from Snapshot. 

4 Activate CEEACE and CMs/SCMs as required. 
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Recovering from SIM-ACE application failure 
Prerequisites 

The following state should exist, representing a fully functional, active ACE node 
running in simulation (SIM-ACE): 

• ACE node is running in simulation (SIM-ACE) 

• ACE/CEEACE function blocks are loaded 

• CM/SCM with strategies built are loaded and active 

Indications of failure 

A SIM-ACE application failure occurs when the either the CDA-sp or EE component or 
both fail). If the SIM-ACE application fails the following occurs: 

• Loss of Communications with Controller event is generated 

• Errors are indicated on the Monitoring tab icons for the ACE, CEEACE, and 
CM/SCM FBs assocaiated with SIM-ACE 

Recovering from application failure 
Use the following procedure to recover from a SIM-ACE application failure: 

 
Step Action 

1 Restore power to SIM-ACE node. 

2 Boot up the SIM-ACE node (all necessary SIM-ACE 
processes starts automatically) 

3 Select ACE FB from Monitoring tab. From the Snapshot 
menu, select Restore Controller from Snapshot. 

4 Activate CEEACE and CMs/SCMs as required. 
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Recovering from OPC Server failure 
Prerequisites 

The following state should exist, representing a fully functional, active ACE node 
running in simulation (SIM-ACE): 

• ACE node is running in simulation (SIM-ACE) 
• ACE/CEEACE function blocks are loaded 
• CM/SCM with strategies built are loaded and active 
• OPC Server function block is successfully loaded 
• SIM-ACE contains control strategies that reference the OPC Server 
• Communication between the SIM-ACE and the OPC Server is normal 

Indications of failure 
An OPC Server failure happens if any of the following occurs: 

• OPC Server component fails 

• The single Ethernet connection to the OPC Server fails 

• OPC Server loses power 

If OPC Server fails the following occurs: 

• Communication errors from SIM-ACE strategies that reference OPC Server data. 
Several process alarms can be reported as a result of: 

− fail-safe data substitution for Gets, and 

− failures for Stores 

Recovering from OPC Server failure 
Use the following procedure to recover from an OPC Server failure: 

 
Step Action 

1 Restore power to OPC Server node, if power was lost. 

2 Repair the failure in the communication link, if needed 
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